Using survey data:
a UK Data Service learning resource

Data Analysis workbook — Examining fear of crime in SPSS

This data analysis workbook shows how to use SPSS to explore data and conduct some
analyses examining fear of crime.

In this worksheet, you will:
® use weighting variables
® examine missing values
explore categorical variables using frequency tables and charts
produce descriptive statistics for a continuous variable
analyse the relationship between categorical variables using crosstabulations

recode and compute variables

Task — Examine fear of crime by analysing the Crime Survey for

England and Wales, 2013-2014

A research project aims to identify factors linked to the fear of crime. In particular, the
research seeks to understand:

® how fear of crime varies by sex and age

@ if arelationship exists between the fear and experience of crime.

The tasks in this workbook are to:

@ get the data ready for analysis (including using a weighting variable) (section 1).
@ explore the key variables (Section 2)

® examine relationships between variables (Section 3)

@® manipulate data to aid data analysis (Section 3)

® introduce a third variable (Section 4)

______________________________________________________________________________________

Follow instructions marked with a = on your computer.
Answers to the numbered questions can be found at the end.

This workbook is supported by our guide Using Survey Data



https://www.ukdataservice.ac.uk/media/455510/using-survey-data.pdf
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1. Get ready

1.1. Open data in SPSS
The worksheet uses the Crime Survey for England and Wales, 2013-2014, which
registered users can download from the UK Data Service.

For a guide to registering, downloading and opening the data in SPSS, see the
worksheets:

® Register and download UK Data Service data

® Getting started with SPSS

Which file?
When you download the Crime Survey for England and Wales, 2013-2014, the zip file
includes four data files.

There are different files for two reasons:
1. data for young people (aged 10-15) is kept separate from the data for adults
(marked with 10-15 on the file name)
2. in addition to data relating to individuals, there are records of data relating to
incidences of crime (marked with a vf in the file name: vf standards for victim
format).
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1.2. Apply the weight
Survey weights make the sample data more representative of the population. It is
therefore important to use weighted results in your work.

® Find out more about weights in the accompanying guide ‘Using Survey data’

You need to apply the weight before you start your analysis; the process is, however,
fairly simple. Follow the instructions below.

Find the weight in the documentation

First, find out the name of the weight(s) in your dataset. Details of weighting variables
are usually contained within a User Guide accompanying the survey data. For data from
the UK Data Service, the documentation is available through:

@ the catalogue record on the UK Data Service website (ukdataservice.ac.uk/get-data)

@ the zip file you downloaded from the UK Data Service

To access the documentation and find details of the weights:

= go to the documentation for Crime Survey for England and Wales, 2013-2014

=» open the user guide for the main adult dataset (7619_csew_adult_userguide.pdf)

= find the section on weights (Tip: when looking at PDFs, press Control-F to search
for ‘weight’)


https://www.ukdataservice.ac.uk/media/455510/using-survey-data.pdf

Which weight do I use?
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Like many datasets, you will find that the Crime Survey for England and Wales, 2013-
2014 contains more than one weight. Why? Different weights are for different types of
analysis. In this case, there are weights to use when analysing individuals, households or

incidents of crime.

For this research, our focus is on individuals, we therefore need to select the weight for

individual level analyses.

Question 1 What is the name of the weight for individual level analyses?

Apply the weights in SPSS
The next step is to apply the weight in
SPSS.

You can either:

= use the menus to select Data >
Weight Cases

= press the weighting icon &
on the tool bar

This will open the 'Weight Cases’
Dialogue box.

In the ‘Weight Cases’ Dialogue box,

= find the weighting variable in the
list on the left (In the CSEW,
2013-2014, the weight for
individual level analyses is called
c1lindivwgt)

= select the variable and move it
into the box on the right > click
OK.

= check the weight is applied by looking at the
bottom right corner of the Data Editor. It should

display ‘Weight On’.

Tip: Names and Labels

Variables tend to have short (often
incomprehensible) names and a more
descriptive label.

SPSS lists variables using either names
or labels. To change from Names or
Labels, right click anywhere on a
variable list. This will open a new menu
allowing you to choose either 'Display
Variable Names or Display Variables
Labels.

In this worksheet, we refer to variables
by their name so you may find it easier if
you select '‘Display Variable Names'.

Wé Weight Cases b
= @ Do not weight cases
growlalbel @ Weight cases by
seria
*5 screen - |

" @ Display Variable Names
5| © Display Variable Labels

Weight On
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2. Explore key variables

With the weight applied, start examining the variables.

2.1. Run frequency tables to explore fear of crime
First, consider the variables measuring our main concept of interest, 'fear of crime’,
which are:

@® walkdark

@® homealon

Check the question wording

Before running analyses, it is important to check how questions were asked in the
questionnaire (which will usually be included in the survey documentation).

Note: you usually would have done this when deciding if the data meets your needs.

For the variable walkdark, the question is shown below.

WALKDARIq [ASK ALL MODULE D RESPONDENTS]
How safe do you feel walking alone in this area after dark? Would you say you feel _READ OUT

MOTE: IF RESPONDENT NEVER GOES OUT ALONE AT NIGHT, PROBE: How safe WOULD
you feel?

Very safe
Fairly safe

A bit unsafe

or very unsafe?

bl ol

® Can you find the question wording for homealon? (tip: remember in a PDF you can use Ctrl+F
and search for the variable name).

Make a frequency table

The variables measuring fear of crime are categorical variables. Categorical variables are
common in survey data because questionnaires include lots of tick-box type questions.
A good way to explore categorical variables is to use frequency tables.

'C,-'l Frequencies

(o)
Run a frequency table in SPSS, S —
= using the menus, select Analyze > grunzcomm =] [ ] waikaark
Descriptive Statistics > Frequencies... A oomos [crers. |
p q gtpcemdiun |
. . . tewmdiqu2 <+ -E()m_qtrap
In the ‘Frequencies’ dialog box, ﬁcaLII:dem
=>» select the variable walkdark. E[Ihomearon |
2 press the arrow to move the variable into f ovolent i
the rlght hand bOX > Cl.iCk OK | Display frequency tables
[ oK ][ Paste ][ Reset ][Cancel][ Help ]

The table will appear in the Output Viewer

window. R
Tip: Clicking on any variable in the list and

i typing ‘w’ will allow you to search variables
i beginning with w.
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Inspect the frequency table
The small table that appears first summarises the number of valid and missing responses.
The larger table gives the frequencies and percent for each category.

Statistics

How safe do you feel walking
alone after dark

I Walid 107412469
Missing | 34541128

How safe do you Teel walking alone after dark

Cumulative

Fraguancy Parcant | Valld Parcant Parcant

Valid Vary safe 3402248 7.8 n.y n.y

Falrly safe 4260885 8.4 9.6 71.2

A bitunsafe 2088782 4.6 19.4 a0.7

ey unsafe 9808664 2.2 8.3 100.0

Total 10741299 23.7 100.0

Missing Refusal 2661 0
Cont know 71816 2
System 34466222 TEA
Total 34541128 76.3
Total 45282427 100.0

Frequency tables are fairly straightforward ways of representing data; however, it is
important to examine them thoroughly to ensure you understand the data.

Question 2 Looking at the table for Walkdark, can you identify any (odd) features of the
data you may need to understand before interpreting the figures?
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2.2. Rescale a grossing weight
A feature of the table above you may have noticed is that the frequencies are very large.

® According to the catalogue record, the sample size in the CSEW 2013-14 is 35,371. In this
table, the number of cases appears to be over 45.5 million!

Grossing weights
The reason why the frequencies in the table above are much larger than the sample size
is the weighting variable.

The weight in the CSEW is designed to gross the frequencies to the population of
England and Wales. A ‘grossing weight' is useful for calculating the prevalence of
phenomena at the nation level. However, because of the large numbers the data appears
overly reliable.

We need to weight the data to get accurate results; but, to get a clear idea of the
variables it is useful to amend the weighting variable to avoid inflating the frequencies.

Weighting can be a confusing aspect of using survey data but the following instructions
will guide you through the process of adjusting the weight variable.

Create a rescaled weighting variable

.....................................................................................................................................

SPSS syntax
The instructions below use SPSS syntax, a language for commanding SPSS.

{ In SPSS, you can run analyses using either menus with dialogue boxes or SPSS syntax.
i Menus and dialogue boxes are a good way to get started with SPSS. But, syntax is often
a more efficient way of running and recording analyses. The efficiency of syntax is the !
i reason it is used here in this example. :

The aim is to rescale the weight to stop [Fiz Eat view Data Transiorm Analhze DireciMarketing Graphs  Utilfied

inflating frequencies from the sample — ' | @ pam 1

counts to the population. To do this, we Open == E H B
. . . . = & Syntax

divide the weighting values for all cases ot

by the mean of the weight.

= Open the syntax editor window using the menus

File > New > Syntax

= Copy the text below in to the Syntax window

COMPUTE rescaledweight=Cl1IndivWgt/1280.21. EXECUTE.
Tip: you need to be precise. Make sure the spelling is correct and include the full stops.
This syntax commands SPSS to create a new variable called ‘rescaledweight’. Values on
this new variable correspond to values on the old weight (CllindivWgt) divided by
1280.21, which is the mean of the original weight.

= Highlight the commands and press the green arrow on the tool bar

i . [
ﬂﬁ .:‘ | L g
- . Run Selection
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Tip: How to get SPSS to calculate the mean of the weight
To use the same procedure for rescaling a grossing weight on other datasets (such as the
CSEW for other years), you will need to identify the mean of the weight. To find the mean of a
variable in SPSS:

= Analyze > Decriptive Statistics > Descriptives
In the ‘Descriptives’ dialogue box.

= Select and move the variable into the box on the right > click OK.
The mean will be reported in the output window.

Change the weight and re-run the frequency table
= Apply the new weight using either the menus or “a
= Re-run the frequency table for Walkdark in SPSS

How safe do you feel walking alone after dark

Cumulative
Frequency Percent | Yalid Percent Fercent
Yalid Wery safe 2658 7.A N7 N7
Fairly safe 3320 9.4 386 7.2
A hit unsafe 1632 46 184 890.7
Yery unsafe 7a 2.2 8.3 100.0
Total g3a0 237 100.0
Missing Refusal 2 .0
Don't know 3] 2
System 26922 T6.1
Total 26981 T6.3
Total 35371 100.0
2.3.  Examine missing values

The next feature to consider is the missing values. Understanding the reasons for any

missing values is important for ensuring you interpret figures correctly.

In the frequency table for Walkdark there are three categories of missing data. In
particular, it is notable that the category ‘System’ has 26,922 missing values!

® Do you know why there are so many missing values?

If attentive when looking at the question wording, you may know the reason why. If not,

try looking at the question again.
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Not everyone was asked the question

In the questionnaire, you can see the text 'ASK ALL MODULE D RESPONDENTS'. This
text indicates that only some survey respondents (those given Module D) were asked the
question.

® Why? Read the following text from the User Guide, which explains the structure of the CSEW
questionnaire.

“The main CSEW questionnaire has a complex structure consisting of a core set of modules asked
of the whole sample, a set of modules asked only of different sub-samples, and selt-completion
modules asked of all respondents aged 16 to 59. Modules include, for example: victimisation,
performance of the criminal justice system (CJS); contact with and attitudes to the police and the
CJS; mobile phone theft; anti-social behaviour; plastic card fraud; and demographic
characteristics of the respondent and household...Respondents are randomly allocated into one
of four sub-samples, A, B, C or D which each represent around a quarter of the overall sample.
When a question is only asked of a sub-sample of respondents this is indicated on the
questionnaire’ (p.8)

Question 3 Why do you think this structure is commonly used in surveys?

Refusal and don't know responses in attitudes questions
We also need to consider ‘refusals’ and ‘don’t know' responses.

If the number is large, it could indicate a problem with the question and for attitudinal
questions, especially, you might want to retain ‘don’'t know’ or ‘refusal’ as valid
responses.

For Walkdark, there are only a small number of don’t know responses and refusals. We
therefore do not need to be too concerned about treating these as missing values in our
analysis. Cases with missing values will be excluded from the analyses.

Tip: It is good practice to report information on the missing values when writing up your
research. When possible explain why data might be missing and consider the potential effects on
the results.



2.4.

With a good understanding of the missing values
you are now able to focus on interpreting the

data in the frequency table.

Examine the frequency table for Walkdark

Interpret the frequencies
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| Percent and valid percent

i In the frequency table,

@ 'Percent’ displays the percent of

higher

or
expected?

Question 4 What percentage feels a bit or
very unsafe walking alone after dark? Is this
lower than you would have

Run and interpret a frequency table for homealon

= Run a frequency table for homealon.

@ 'Valid Percent’ displays the

How safe do you feel when alone in home at night
Cumulative
Frequency | Percent | Walid Percent Percent
Valid Very safe f458 15.4 64.6 G4.6
Fairly safe 2376 6.7 281 §2.8
A hit unsafe 444 1.4 58 98.6
Yery unsafe 117 ] 14 100.0
Total 444 2348 100.0
Missing Don't know ] 0
System 26922 TG
Total 26927 761
Total 35371 100.0

cases in each category.

percent of cases in each
category excluding the missing
values.

Usually, it will make more sense
i to refer to the valid percent when
| interpreting the data.

Question 5 What percentage feels either a bit or very unsafe when home alone?

Is this higher or lower than the proportion feeling unsafe walking alone after dark?
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2.5. Use charts to show fear of crime

We can also present the information from the previous table using bar or pie charts.

Make a bar chart How safe do you feel when alone in home at night
To get a bar chart, 6.000-
= open the Frequencies dialog
bOX 5,000
In the Frequencies dialog box, +oo0 ]
2 click Charts r
=>» Select Bar charts and Select 3
Frequencies > press s
Continue
= In the Frequencies dialog 2o
box, click OK
1,000
You should get the chart on the
rlg ht ’ Verylsafe Fairl\fI safe A bit L,:nsafe Very L:ﬂSEfE

How safe do you feel when alone in home at night

Cases weighted by rescalzdweight

The bar chart shows the frequencies for the valid categories. From the chart, ‘very safe’
is clearly the largest category.

® Try copying and pasting the chart into a Microsoft Word document

Pie chart

You can also use a pie chart to show the percentages in each category. To create a pie
chart,

open the Frequencies dialog box

select Charts How safe do you feel when alone in home at night
Select Pie Charts and select Eib‘:"f'f
Percentages > press Continue B very unaate
In the Frequencies dialog box, click

OK

CMissing

v vy

The pie chart here shows a high proportion
of missing values. The number of missing
values is high because not all respondents
were asked this question (as discussed on
page 8). Within this in mind, do you think this
pie chart is easy to interpret?

Which chart to use?
There is not one correct chart for exploring
VarlableS For example Cases weighted by rescalzdweight

@ a pie chart can highlight either a notably large or small proportion of responses

@ a bar chart of the raw counts can usefully show how many people answered the question

10
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2.6. Use descriptive statistics and a histogram to explore experience of crime

Next, examine the variables measuring experience of crime, which are:
@® delibvio

@® ndelibv

Check the question wording
Like with the questions on fear of crime, it is important to first check the questionnaire
to understand how the questions were asked in the survey.

® Can you find the question wording for delibvio and ndelibv?

DELIBVID [ASK ALL]

22
And again, [apart from anything you have already mentioned], since the first of
[*DATE*] has anyone, including people you know well, DELIBERATELY hit you with
their fists or with a weapon of any sort or kicked you or used force or violence in any
other way?

1. Yes
2. Mo

HDELIBV [ASK IF DELIBVIO = YES‘
How many times has this happened?
MOTE: 97 = 97 OR MORETOO MANY TO REMEMBER. USING CODE 97 CAN CAUSE
PROBLEMS IN SEPARATING SINGLE AND SERIES INCIDENTS, S50 PROBE FOR BEST
ESTIMATES WHERE POSSIBLE

1..96
T Mareftoo many to remember

The first question refers to a date. Find out more about the timeframe in the question by
scrolling further up the document until you find the start of this question module.

Question 6 The questions ask about experiences over the .........

What else is referred to in the framing of the question?
How might these references affect responses?

Question routing
The second question of ‘'how many times this happened?’ is understandably only asked

of participants who have experienced deliberate violence. This is a form of question
routing.

Question 7 How might the question routing affect the number of valid and missing
cases on ndelibv?

11
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Run frequency tables
Make frequency tables for delibvio and ndelibv

= Analyze> Descriptive Statistics> Frequencies

If anyone has deliberately used forcehiolence on adult respondent

Cumulative
Frequency | Percent | Valid Percent Percent
Yalid Yes 647 1.8 1.8 1.8
Ma 3472 982 982 100.0
Total 35368 1000 100.0
Missing Refusal 0 0
Don't know 3 0
Total 4 0
Total 353N 100.0
How many times has this happened (Delibvio)
Cumulative
Frequency | Percent | Valid Percent Percent
Walid 1 466 1.3 720 720
2 50 3 134 8549
3 26 A 4.0 8949
4 20 A 3.0 93.0
5 14 0 21 951
6 4 0 i 9587
= 3 0 A 96.2
g 1 0 A 96.3
10 4 0 G 96.9
L3 11 1 a A §97.0
12 0 a A 971
15 3 a A 97.6
20 1 a A 977
24 4 0 7 984
40 2 0 4 98.7
50 1 0 2 98.9
a7 i 0 1.1 100.0
Total 648 1.8 100.0
Missing Don't know 0 0
System 34724 982
Total 34725 482
Total 3531 1000
Question 8

What proportion has experienced deliberate violence?

Out of those who have experienced violence, how many times has it usually
happened?

12



Obtain descriptive statistics

The variable ndelibv counts the number of times a
respondent experienced force/violence used against them
in the previous year.

Frequency tables are not always a helpful way to examine
the distribution of variables with quantitative
measurement scales as often there are too many possible
values.

We can summarise interval variables using summary
statistics such as the:
e minimum and maximum values reported
e mean (average) and median value
e the standard deviation (a measure of the spread of
the data)

To get descriptive statistics for a variable using the menus,
= select Analyze> Descriptive Statistics> Descriptives
= select ndelibv from the list
2 click OK

Descriptive Statistics
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Tip: Select Options to
choose which summary
statistics SPSS reports

1 1
1 1
| 1
| 1
1 1
1 1
1 1
1 1
1 1
1 1
1 1
1 F 5 |
' ﬂ-\ Descriptives: Options [&_J '
| __ |
! [ Sum !
1 - 1
1 1
: Dispersion :
' [ Std. deviation [¥ Minimum '
| [7] variance [¥] Maximum |
1 1
! [[] Range [[] SE mean !
1 1
| Distribution |
1 - - 1
: || Kurtosis || Skewness :
1 1
1 1
1 Display Order 1
1 1
' @ Variable list '
| © Alphabetic |
1 1
! © Ascending means !
' © Descending means | !
1 1
i [Conﬂnue][ Cancel ][ Help ] | i
1 L]
1 1
1 — 1

____________________________

N Minimum Maximum Mean Std. Deviation
How many times has this
646 1 97 3.06 10.659
happened (Delibvio)
Valid N (listwise) 646

Warning: Always refer to the question wording

If we examine the question wording (shown on page 11) we find that “97" stands for “97
or more /too many to remember”. This feature of the data is important. If the seven
cases of "97" mean “"too many to remember” rather than “97 or more” our interpretation
of the mean and maximum values is incorrect. (As the next largest frequency is 50, the
frequency table suggests that the 97’s most likely mean “too many to remember).

What do we do?

An appropriate response may be to treat these seven values as missing (section 4.2 later
in the guide includes instructions on how to indicate missing values).

13
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The table below gives the descriptive statistics based on the remaining 639 cases.

Descriptive Statistics

N Minimum Maximum Mean Std. Deviation
How many times has this
o 639 1 50 2.02 3.965
happened (Delibvio)
Valid N (listwise) 639

Question 9 Complete the text to summarise the variable?

From the people who have experienced violence against them in the last year, the
number of incidences were between and . The average was____.

Question 10 Why are there no cases reporting 0 incidents of violence?

2.7. Make a histogram

A good way to look at the distribution of an interval variable is to use a histogram. A
histogram groups values into ‘bins’ with bars to show the distribution of responses
across the values.

One way to produce a histogram is to use the legacy dialog box:

= Select Graphs> Legacy dialogs> Histogram,
= Select ndelibv from the variable list.

500 Mean = 202
Stel. Dev. = 3 965
| N=639.22

400

o
8
i

Frequency

2004

1009

0 10 2 a0 40 50 60
How many times has this happened (Delibvio)

Cases weighted by rescaledweight

The histogram for ndelibv, above, shows that most people who have been victims of
violence, have only been victims once or a small number of times and that there are a
smaller group of victims who have suffered many repeated violent attacks.

14
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3. Examine relationships between variables: how fear of crime
relates to sex and age

The previous sections have given us a good understanding of the key variables.

For example, in relation to the fear of crime, analysing the variables Walkdark and
homealon suggests that:

@® a majority of adults feel at least fairly safe walking alone and at home alone after dark
® nearly 30 percent of adults feel either a bit or very unsafe walking alone after dark

@ a much greater proportion feel unsafe walking alone than home alone after dark (nearly 30
percent compared to less than 10 percent)

With this understanding of the key variables, you can start to examine the relationships
between variables. In this section, we use bivariate analyses to establish if fear of crime
relates to a person’s sex and age.

In both cases, the analysis will relate to the relationship between two categorical
variables. We will therefore use

@ crosstabulations
® chi-square test

@® stacked bar charts
3.1. Hypotheses

Before starting analyses, it is useful to consider what types of patterns you might expect
to find. Thinking about the following questions:

@ will fear of crime vary by sex? If so, are males or females more likely to report feeling unsafe?
® Are younger or older adults more likely to be concerned about their safety?

® will sex and age differences vary in relation to ‘walking alone’ or being ‘home alone’?

....what patterns might you expect to find and why? (make some notes)

15
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3.2. Crosstabulation of walkdark by sex

Before bivariate and multivariate analyses, you should examine each of the variables
individually. We have examined the dependent variables walkdark and homealon but not
the ‘explanatory’ variable sex.

Start by examining sex:
= Select Analyze> Descriptives> Frequencies

Run a crosstabulation
Using the variable walkdark, examine whether feeling unsafe varies between males and
females:

= select Analyze> Descriptives> Crosstabs...
= Put Walkdark in the Row(s)
= Put sex in the Column(s)

TS — - — | What goes in the row and what in
Row(s): = i the column?

%;‘:‘:‘;be' o D | It does not really matter which
& sareen ; i variable goes in the row and |
& vear Column(s): — E . . ;
S vamptpe é“;"e"xs i which in the column. i
e s e
& suospit i Though, in the social sciences |
& hselec Layer 1 of 1 [ :
& adults_s ¢ itis common to i
&5 numcheck i :
dults_i ! . |
%;Euﬁgl @ put the output variable (the one :
& sex = ; you are interested in i
& sexd = 5 explaining) in the row i
; i

L] Display clustered bar charts ! @ the explanatory variable (the i
| Suppressiples 5 one that might influence the !
(Lok_J{ paste [ Reset ||ancel || Help | : other) in the column 5

Ask for percentages

In this example, we are interested in looking at the effect of sex on fear of crime. When
comparing groups, percentages for each group should add up to 100 percent. Sex is in
the columns, we therefore need to ask for column percentages.

r@ Crosstabs: Cell Display ﬁ1
= Select the box Cells from the right
Counts test
[# Observed [] Compare column proportions
In the Crosstabs: Cell Display dialogue box [ Bxpectes
= Select column percentages > click [ Hide small counts
Continue |
Percentages Residuals
You are now ready to make your table. In the o — gnstanderdized
[ ["] Standardized

crosstabs dialogue box =
= Click OK

| Total [7] Adjusted standardized

Moninteger Weights
@ Round cell counts @ Round case weights
@ Truncate cell counts @ Truncate case weights

© No adjustments

[Conﬁnue][ Cancel ][ Help ]

16
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Interpret the two-way table (crosstab)

You should see the following table:

How safe do you feel walking alone after dark * Adult number 1 (respondent): Sex Crosstabulation
Adult number 1 (respondent):
Sex
Male Female Total

How safe do you feel YWery safe Count 1868 790 2658

walking alone after dark % within Adult number 1 45.4% 185% | 31.7%
(respondent): Sex

Fairly safe Count 1630 16480 3320

% within Adult number 1 39.6% 38.5% 39.6%
(respondent): Sex

Abitunsafe  Count 475 1157 1632

% within Adult numhber 1 11.6% 27.0% 19.4%
(respondent); Sex

Weryunsafe  Count 138 643 781

% within Adult number 1 3.4% 15.0% 9.3%
(respondent); Sex

Total Count 41111 4280 23

% within Adult number 1 100.0% 100.0% 100.0%
(respondent); Sex

What does this table tell us?

31.7 percent of adults report feeling ‘very safe’ walking alone after far (see the Total
column on the right) but the proportion for women is only 18.5 percent.

Question 10 What proportion of females feel 'very unsafe’ walking alone after dark?
How does this compare to males?

17
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3.3. Make a stacked bar chart
A stacked bar chart is a good way to represent the differences by sex.

o —— — - - - .

ting Graphs Utilities Add-ons Window Help

Use Chart Builder to make a stacked bar chart
i) Chart Builder... %

To make a stacked bar chart, using the menus, !’m
= choose Graphs> Chart Builder...

In the Chart Builder dialogue box,

F B
{3 Chart Builder — - - =5

Egiablelgb ‘ Chart preview uses example data |n the preview box
rowlabe -

&b serial

&b screen
&b vear

&b samptype
&b split

&b subsplit
&b hselec
&b adults_s
&b numcheck

&b adults_i

B s

[ Category 1
BB Ccategory 2
Gall i i
U nder allery [BamcElemenm”G(mpaPMID” Tmesfoomotesl Element
Properties_

%Sﬁo;sa;do‘m = drag sex to the
| feel walking alone ..

T I X axis

= drag walkdark
to the Stack

R Male Female

Fercentage

(@b Adultnumber 1 (respondenty Sex |

‘Choose from:’ Ghoose from:
Connes N
= select Bar :'r';: HHH
=> select the PieiPolar — w00
H Scatter/Dot 1]
pICture Of Histogram “ . q; ¢ ¢.
the High-Low 1
B
stacked P e
!
bar chart =7

(Lo J(paste |( Reset | (cancel || Help |

L — —— = -——— = = A

Use percentages to compare groups
Then, in Element Properties

rg Element Properties M-‘

= Select Percentage... as the statistic Zg”fm““‘“ . 26
=» Press '‘Set Parameters...’ x.a,;,dsﬂaam
= Select ‘Total for Each X-Axis Category for the \;-Axiifﬁla':; . -

denominator’. Statistics
= Click Apply Variable:

Statistic:
Back in Chart Builder, Eaissnaced ]

= Click OK
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Examine your chart
You should have the following graph.

100.0%=

80.0%

G0.0%—

Percent

40.0%

20.0%

Male Female

Adult number 1 (respondent); Sex

How safe
do you feel
walkin
alone after
dark

W ery safe
[ Fairly safe
1 A hit unsafe
M ery unsafe

Using survey data:
a UK Data Service learning resource

The graph shows how feelings of safety walking alone after dark vary between males
and females. For example, we can see that the proportion of females that feel either a bit
or very unsafe is about 40 percent compared to less than 20 percent of males.
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3.4. A chi-square test

When examining relationships between categorical variables, a Pearson'’s chi-square test

is commonly used.

Pearson’s chi-square is a test of
statistical significance. It is used to
evaluate how likely it is that any
observed difference between
groups have occurred by chance.

Get the Chi-square
In SPSS, you can get a chi-square
test through the crosstab menu.

= Analyze>Descriptive
Statistics>Crosstab

In the Cross-tabs dialogue box,
= select Statistics...(on
right)

the

This will open a new dialogue box,
= select Chi-square
= press Continue

In the Cross-tabs dialogue box,
= press OK

Inspect and interpret the result

The results appear in a table where the first row reports the Pearson Chi-square Value,

ﬁ-\ Crosstabs

Using survey data:
a UK Data Service learning resource

p
H Cre bs: Statistics X
& rowlabel - - R
& senal [¥l|Chi-square |[] Correlations
@b screen
&b year Mominal Ordinal
&’ samptype || Contingency coefficient "] Gamma
split B _
& sp ) [] Phi and Cramer's V [] Somers' d
&5 subsplit - =
& hselec [[] Lambda [7] Kendall's tau-p
&5 adults_s || Uncertainty coefficient ["] Kendall's tau-c
&5 numcheck
&b adults_i Nominal by Interval [7] Kappa
é{_, nadults []Eta [ Risk
&’ sex2 [ MeNemar
@b sexd
= * [] Cochran's and Mantel-Haenszel statistics
[] Display clust
["] Suppress ta [Contlnue][ Cancel ][ Help ]

degrees of freedom and the significance value.

Chi-Square Tests

Asymp. Sig.
Yalue df (2-sided)
Pearson Chi-Square 10468477 3 000
Likelihood Ratio 1095934 3 000
Linear-by-Linear 1031.828 1 000
Association
M ofvalid Cases 2381

a. 0 cells (0.0%) have expected count less than 5. The minimum

expected count is 382.64.

between sex and fear of crime?

Question 11 Does the test suggest there is a statistically significant relationship
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Assess reliability
For chi-square test results to be reliable there needs to be

@® no more than 20% of the cells with expected counts of less than 5

® no cells with a count of less than 1.

Question 12 Check the expected cell counts given below the Chi-square results. Does the
data meet the requirements of the chi-square test?

3.5. Crosstab sex and homealon

We have found sex differences in fear of crime using the variable walkdark. However, do
we still find differences by sex when we examine feelings of safety when home alone at
night.

=>» Follow previous steps to run a crosstab with a chi-square test to examine the
relationship between sex and feelings of safety when home alone at night
(homealon).

Add the missing information to the table below and answer the questions.

Table 1 How safe do you feel when alone in home at night by sex

Male Female Total
Very safe 76.7% 64.6%
Fairly safe 28.1%
A bit unsafe 9.0%
Very unsafe 4% 2.3
Total 100.0% 100.0% 100.0%
n= 4317

Pearson Chi-Square (x%)=561.883, p<0.001

Question 13 Are males or females more likely to feel safe at home at night?

According to the Pearson chi-square test, can we say there is a statistically significant
relationship between sex and feelings of safety at home at night?
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3.6. Differences by age: crosstabulations using a categorical age variable

The next step is to examine how fear of crime relates to age.

Select your variables
We will continue to use walkdark and homealon to measure fear of crime but how will we
measure age?

If we measure age in age-bands we can use crosstabulations to explore the relationship
between age and fear of crime. Fortunately, the dataset already includes three variables
that measure age in bands.

Variable Name Variable label

agegrp Age group (3 bands
ageshort Age group (5 bands)
agelong Age group (9 bands)

From the labels, we see that the

first variable consists of 3 age | Tip: you can ask SPSS to run tables for multiple
bands, the second 5 age bands and | variables simultaneously. Simply add all variables to

the third 9 age bands. the list in the Frequencies dialogue box.
r"@ Frequencies — o ﬁ
Examine the variables to find out .
Variable(s) L
the age bands. & agen_rpr = & agegp
= Run frequency tables for o agepers & agelong S
& agetot &) ageshort
agegrp, ageshort, agelong & agetot i =
& agetot_p m

Select an age variable to use.

Which one to use?
There is no ‘correct’ number of groups. Factors to consider include:

@ categories need to be meaningful (keep together groups likely to share common experiences)
@ too few categories can conceal important differences

® too many categories makes interpretation difficult and some percentages are based on only a
very small number of cases

Run and interpret crosstabulations
= Using the same methods as for sex, produce two-way tables to examine if fear of
crime varies across age groups.

Question 14 Is age related to feeling unsafe walking alone after dark? Summarise
the pattern with reference to the percentages in the table.
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4. Manipulate data to aid data analysis

In this section, you will create new variables to aid analysis.

4.1. Recode to create binary variables
For certain analyses, it can be easier to simplify variables in a dataset by combining
response categories.

For instance, we can create simpler measures of the fear of crime by recoding walkdark:
@ the original variable has four main categories (Very safe, Fairly safe, A bit unsafe and Very safe)

@® combining categories, the simpler measure will indicate whether someone feels unsafe
(yes/no) walking alone after dark

® these binary variables will take the value 1 if the respondent feels either ‘a bit’ or ‘very’ unsafe
and O if ‘'very’ or ‘fairly’ safe

Check how variables are coded
Before we can recode an existing variable, we need to know how it is coded. You can
check how variables are coded in the Variable View window.

m

Data View | Variable View

In the Variable View window,
= identify the row for the variable of interest and in that row, click in the Values

column
143 qualif2 Numeric 8 0 How much quality of life is affected by CRIME {98, Refusal}
144 quallife Numeric 8 0 How much quality of life is affected by FEAR ... {98, Refusal)
145 walkdark Numeric 8 0 How safe do you feel walking alone after dark |{1, Very safe}... ( E]
146 outalon2 Numeric 8 0 How often do you walk alone in dark during S... {1, At least once a week}

= Click the box with "..." to open the Value Labels dialogue box.

1=

In the Value Labels dialogue box, you 2 — - —
can see the value for each response Value Lapels
category. vage [ ]
For instance, in this case those cases Labet | |
responding “Very Safe” will be assigned ;E:mf:;e
the value 1. 3="Abitunsafe”

4 ="ery unsafe”
Plan the recode e
The next step is to identify how to
recode the existing variable into your || (_ok_](cancel]( Hep |
new variable. L

It is useful to use pen and paper to write down a list of the old and new values and their
labels.
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® Question 15 using the information above, can you plan the recode for the new variable
identifying those who feel unsafe walking alone after dark?

Existing Variable = Walkdark New Variable= unsafedark
Value Label Value Label
1 Very safe
0 No
2
- T 1 Yes
8 Refusal
9 Don’t know

tata Transform Analyze Direct Marketing Graphs U

Recode into different variables...
With a plan, you can start the recode.

ﬁ Compute Variable...

[ count values within Cases.

) Shift Values_. el

= select the menu Transform > Recode into ) . Ern
Diff Variabl & Recode into Same Variables. ont
Ifferent Variables... [&] Recode into Different Variables... ial

Rather than changing the original variable, this command creates a new variable as part
of the recode.

@ Itis generally better to create a new variable and keep the original variable intact in case you
make mistakes or change your mind.

Name the old and new variable
In the dialogue box, first indicate the existing variable in dataset:

9 from the Va ria ble list, "@ Recode into Different Variables - &J
select Walkdark g _ Numeric Variable -= Output Variable: Output Variable
. . vshowc = walkdark —= unsafedark .
= move the variable into & vehowa —E‘:S":m
the ‘Numeric Variable |[|%on Labet
_—>Output Variable’ box ||| e
Name and label the new ||$7
variable using the Output | |&=o
Variable box, %:ﬁ:?ﬁa
9Itype ’Ealnsafedark’ undel’ ﬁ::ﬁ::;ﬂ g (nptmnalcaseselemmncnndmnn}
Name
= type ‘feels unsafe = =

walking alone after dark (recoded binary measure)’ under ‘Label’
=> click Change
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Specify the values
Now tell SPSS how to recode the existing variable into the new variable.

=>» click the Old and New values button

This opens a dialog box. To recode old to new values, you can:
=> click Value on the left and add the value 1
=> In the New Value area type 0 and click Add.

"Q-\ Recode into Different Varables: Old and Mew Values - - @
Old Value Mew Value
@ value: @ value: || |
|‘1 | © system-missing
© System-missing © Copy old value(s)

© System- or user-missing

© Range: Old —= Mew:

Add

You have now defined the first new value. The new variable will take the value 0 when
walkdark= 1.

Follow the same procedure to indicate values of the new variable when walkdark=2.
=> click Value on the left and add the value 2, in the New Value area type 0

=> click Add

An alternative way to recode consecutive values of an existing variable is to use the
range option.
=> on the left, click ‘'Range:’ and insert 3 in the upper box and 4 in the lower box

=>» in the New Value area type 1 and click Add.

Finally, the code of the missing values is staying the same, so you can use the follow
option

= On the left, click ‘All other values'. In the New Value area click ‘Copy old Value(s)'
and click ‘Add’

You should have following in the Old - New box.

01d —= Mew:
1—=0

2—=0

3thrud —=1
ELSE —= Copy

= click Continue to return to the Recode into Different Variables dialog box
2 click OK
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The new variable unsafedark should now be visible at the end of your data in the Data
Editor.

2645 bcageband02 Numeric 8 0 Household chil... {1, 0-4}... MNaone 13 =
2646 bcageband03  Numeric 8 0 Household chil.._ {1, 04} MNone 13 E
2647 bcageband04  Numeric 8 0 Household chil... {1, 0-4}... Naone 13 =
2648 bcageband05  Numeric 8 0 Household chil.._ {1, 04} MNone 13 E
2649 bcageband06 MNumeric 8 0 Household chil... {1, 0-4}... Naone 13 =
2650 bcageband07  Numeric g 0 Household chil... {1, 0-4}... MNone 13 E
2651 bcageband08 MNumeric 8 0 Household chil... {1, 0-4}... MNone 13 =
2652 bcageband09  Numeric g 0 Household chil... {1, 0-4}... MNone 13 E
2653 bcageband10  Numeric 3 0 Household chil.._ {1, 0-4}... MNone 13 E
2654 rural3 Numeric g 2 Type of area 20... {1.00, Urban... None 10 =
2655 rescaledwei... Numeric 8 2 Mone MNone 16 E
2656 unsafedark  Mumeric 8 2 feels unsafe wa... None MNone 12 =
2657

2658

2659

Check the distribution of the new variable
After any recode, it is useful to check the distribution of the new variable.

=» create a frequency table for the new variable (Analyze> Descriptive Statistics>
Frequencies...)

In the frequency table (below), the new variable looks as expected. The variable takes
the values of O, 1, 8 or 9. But, the table highlights how to complete the recode we still
need to:

@ add value labels to show what each value represents

@ indicate that responses 8 or 9 should be classed as missing values

feels unsafe walking alone after dark (recoded binary measure)

Frequency Percent Valid Percent Cumulative
Percent
.00 5978 16.9 70.8 70.8
1.00 2412 6.8 28.6 99.3
Valid 8.00 2 .0 .0 99.3
9.00 56 2 a7 100.0
Total 8449 23.9 100.0
Missing  System 26922 76.1
Total 35371 100.0
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Label the categories in your new variable
Assigning value labels to the new variable will show what each value represents. To add
value labels:

=>» find the variable in the Variable view in the Data Editor
=>» click on the cell in the Values column
= click on the box with "..." that appears when the cell is highlighted

@*csew_apr]ﬂmarlil_mrf_l..sav[DataSetl]—lBMSPSSStat]stics Data Editor - -
File Edit View Data Transform Analyze DirectMarketing Graphs Utilities Add-ons Window Help

SHSE c ~ BLF K B BE o3¢

MName Type Width | Decimals Label WValues Missing Columns
2653 bcageband10 MNumeric 8 0 Household chil... {1, 0-4}... Mone 13
2654 rural3 MNumeric 8 2 Type of area 20 |{1.00, Urban_.. Mone 10
2655 rescaledwel... MNumeric 8 2 Mone Mone 16
2656 unsafedark  Numeric 8 2 feels unsafe wa one 12
2657
2658

The value labels dialog box will appear. Using this box, you attach value labels by
indicating the 'Value' and corresponding ‘Label’.

To label the new variable,
= type 0 in the 'Value' field and 'No’ in the ‘Label’ field. Click Add.

=> repeat this process for 1 ‘Yes’, 8 ‘Refusal’ and 9 Don't know’ to get the following:

"@ Value Labels @
Value Labels
Value: |:| Spelling .
Labet| |
.00 ="Mo”
5.00 ="Refusal

9.00 ="Dont know™

| oKk || cancel|[ Heip |

If you make any mistakes, use the Change and Remove buttons.

=>» select OK when finished
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Missing values
You also use the variable view to indicate that certain response categories should be
classed as missing values.

= find the variable in the Variable view in the Data Editor

= click on the cell in the Missing column

= click on the box with "..." that appears when the cell is highlighted

+|._,-'I *csew_aprl3marld_nvf_l.sav [DataSetl] - IBM SP3S Statistics Data Editor - -

File Edit View Data Transform Analyze DirectMarketing Graphs Utilities Add-ons Window Help

SHE M o ~ Eigss

=
l
1
17
il
o

Name Type Width | Decimals Label Values Missing Columns
2653 bcageband10 Mumeric 8 0 Household chil... {1, 0-4}._. MNone 13
2654 rural3 MNumeric 8 2 Type of area 20 {1.00, Urban... None 10
2655 rescaledwei... Numeric 8 2 MNone
2656 unsafedark  Mumeric 8 2 feels unsafe wa... None
2657

The Missing Values dialog box will appear with different options for indicating values.
r"@ Missing Values Iﬁ1

® Mo missing values

{© Discrete missing values

(&) Range plus one optional discrete missing value

[ DK ][Cancel][ Help ]

In this case you can either,

=> select ‘Discrete missing values’ and typing 8 in the first box and 9 in the second
or

= select 'Range plus one optional discrete missing value’ and type 8 in the ‘Low’
field, 9 in the ‘High’ field (leaving the ‘Discrete value’ field empty.

= select OK when finished
To check the labels and indicating of missing values has work, we can create another

frequency table
= Analyze> Descriptive Statistics> Frequencies...
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42. Crosstabulate new variable with original to check recoding
When you create a new variable you should check the coding is as you expect. To check
a straightforward recode, you can use a crosstabulation of the original and new variable.

= Analyze > Descriptive Statistics > Crosstabs
= move the variable walkdark to the Row(s) and unsafedalk into the Column(s)

The crosstabulation of the variable (shown below) confirms that those who responded
‘Very safe’ or 'Fairly safe’ fall into the ‘No’ group on the new variable. Conversely, those
who indicated that they feel either ‘a bit unsafe’ or ‘'very unsafe’ are in the 'Yes' group.

How safe do you feel walking alone after dark * feels unsafe walking alone after dark

(recoded binary measure Crosstabulation

Count
feels unsafe walking alone after Total
dark (recoded binary measure
No yes

Very safe 2658 0 2658
How safe do you feel Fairly safe 3320 0 3320
walking alone after dark A bit unsafe 0 1632 1632

Very unsafe 0 781 781
Total 5978 2413 8391

4.3. Using the recoded variable
You can now use the newly coded variable in your analyses.

Creating simple measures such as this binary measure indicating whether someone does
or does not feel unsafe walking alone after dark can be useful in data analysis. For
example,

® reducing the number of categories can make results easier to present and interpret and
increase the number of cases within the different categories

@® compared to ordinal measures, binary dependent variables are more easily analysed in
multivariate analyses

But, thinking about the differences between Walkdark and Unsafedark, identify any
disadvantages in recoding variables in this way?
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5. Introduce a third variable

The previous analyses have been either univariate (looking at one variable) or bivariate
(looking at the relationship between two variables). This sections, extends into more
complex multivariate analyses.

Using three variables, the aim is to establish if:
@ there is a relationship between experience and the fear of crime

@ the relationship is the same between males and females

To address these aims, we will:

@ use a crosstabulation to examine the relationship between the experience and fear of crime

@ include sex as a third variable to make a three-way crosstabulation

® conduct and interpret a chi-square test for a three-way table

5.1. How does fear of crime relate to experience of violence?

Delibvio measures experiences of violence and the use of force. Exploring this variable in

section 2, we found that just under 2 percent had experienced violence or the use of
force during the 12 months prior to the survey.

Run a crosstabulation
Using a crosstabulation, we can examine if such experiences of crime are linked to the
fear of crime.

=> analyze > Descriptive Statistics > Crosstab
= put walkdark in rows, delibvio in columns
= in ‘cells’ choose column percentages

= in 'statistics’ choose Chi-square

@® You could also try using the simpler measure unsafedark derived in the previous section

Interpret the table and the chi-square test (see over page).

Question 16 Do feelings of safety walking alone after dark vary according to
experience of violence?

Does there appear to be a statistically significant relationship between experience
of violence and the fear of crime?
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How safe do you feel walking alone after dark * If anyone has deliberately used forceiiolence on adult respondent

Crosstahulation

Ifanyone has deliberately used
forcefviolence on adult

respondent

Yes

Mo

Total

How safe do you feel

walking alone after dark

Very safa

Count

% within If anyone has
deliberately used
forcelviolence on adult
respondent

2615
31.7%

2657
31.T7%

Fairly safe

Count

% within If anyone has
deliberately used
forcefviolence on adult
respondent

61
40.9%

3260
39.6%

33
39.6%

Abitunsafe

Count

% within If anyone has
deliberately used
farcefviolence an adult
respondent

31
20.8%

1601
19.4%

1632
19.4%

YWery unsafe

Count

% within If anyone has
deliberately used
forcelviolence on adult
respaondent

15
10.1%

766
9.3%

781
9.3%

Total

Count

% within If anyone has
deliberately used
forcelviolence on adult
respondent

1449
100.0%

8242
100.0%

83m
100.0%

Chi-Square Tests

Value df Asymp. Sig. (2-
sided)

Pearson Chi-Square .888° .828
Likelihood Ratio .903 .825
Linear-by-Linear

. .696 404
Association
N of Valid Cases 8391

a. 0 cells (0.0%) have expected count less than 5. The minimum

expected count is 13.87.
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5.2. Introducing a sex variable

Exploring the key variables in section 2, we found females tend to be more afraid of
crime than males. This increased level of fear may result from general socialisation
processes rather than actual experiences of crime. Thus, the relationship between the
experience and fear of crime could be different for males and females.

A three-way table, allows us to examine the effect of the fear of crime among males and
females separately.

Run a three-way table and chi-square test

To create a three-way table to examine

gender differences in the relationship Row(s):
between experience and fear of crime, %walkdark
we need to add Sex as a layer in the
crosstabulation.
> Analyze> Descriptive Statistics> E;”m”_iﬂ}f
Crosstab... delibvio
= Put walkdark in the rows, delibvio hnd
in the columns
= Add sex as a layer Layer 10f 1
= Click on Cells and choose column _—
percentages =
= Click on Statistics and select Chi- & sex

square
=» Press OK

Interpret the results

The three-way table presents values for males only, females only and the overall results
(which are the same as earlier). Examining the differences, we can establish if the pattern
is the same for males and females.

Question 17 Among males, which of the following statements applies?
[1 Those who have and have not recently experienced violence show not
difference is feelings of safety walking alone after dark
[1 Those who have recently experienced violence feel less safe walking alone
after dark
[1 Those who have recently experience violence feel more safe walking along
after dark

Is the pattern the same for females?

32




Using survey data:

a UK Data Service learning resource

How safe do you feel walking alone after dark * If anyone has deliberately used force/violence on adult respondent *
Adult number 1 (respondent): Sex Crosstabulation

Adult number 1 (respondent): Sex If anyone has deliberately used force/violence Total
on adult respondent
Yes No
31 1837 1868
Very safe
32.0% 45.8% 45.4%
45 1585 1630
Fairly safe
46.4% 39.5% 39.6%
15 460 475
Male A bit unsafe
15.5% 11.5% 11.6%
6 132 138
Very unsafe
6.2% 3.3% 3.4%
97 4014 4111
Total
100.0% 100.0% 100.0%
12 778 790
Very safe
23.1% 18.4% 18.5%
15 1675 1690
Fairly safe
28.8% 39.6% 39.5%
16 1141 1157
Female A bit unsafe
30.8% 27.0% 27.0%
9 633 642
Very unsafe
17.3% 15.0% 15.0%
52 4227 4279
Total
100.0% 100.0% 100.0%
43 2615 2658
Very safe
28.9% 31.7% 31.7%
60 3260 3320
Fairly safe
40.3% 39.6% 39.6%
31 1601 1632
Total A bit unsafe
20.8% 19.4% 19.5%
15 765 780
Very unsafe
10.1% 9.3% 9.3%
149 8241 8390
Total
100.0% 100.0% 100.0%

Tip: Three-way tables tend to be fairly large. To help the table above fit on a page, some less
necessary information has been removed. Reformatting output from SPSS can help to present
results better. (you could also try examining a recoded variable such as Unsafedark from the

previous section).
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Chi-square test for a three way table
For the three-way table, there are separate chi-square tests for

@ the relationship between experience of crime and fear of crime for men
@ the relationship between experience of crime and fear of crime for women

@ the relationship between experience of crime and fear of crime overall

Chi-Square Tests

Asymp. Sig.
Adult number 1 (respondent): Sex Value df (2-sided)
Male Fearson Chi-Square 8.704" 3 032
Likelihood Ratio 8.600 3 .035
Linear-hy-Linear 8.369 1 .0o4
Association
M ofValid Cases 4111
Female Pearson Chi-Square 2.576° 3 AE2
Likelihood Ratio 2.667 3 448
Linear-hy-Linear 081 1 FIT
Association
M ofValid Cases 42749
Total Fearson Chi-Square 6407 3 BE7
Likelihood Ratio .G45 3 .Ba6
Linear-hy-Linear 564 1 453
Association
M ofValid Cases 8350
a. 0 cells (0.0%) have expected count less than 5. The minimum expected count
is 13.85.
b.1 cells (12.5%) have expected count less than 5. The minimum expected count
is 3.26.
c. 0 cells (0.0%) have expected count less than 5. The minimum expected count
is 7.80.

Question 18 According to the Pearson Chi-square test, is there a significant association
between fear and experience of crime...
...among males?

...among females?
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Question 2

Question 3

Question 4

Question 5

Question 6

Question 7

Question 8

Question 9

Question 10

Question 11

Question 12

Question 13
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What is the name of the weight for individual level analyses?
cllindivwgt

Looking at the table for Walkdark, can you identify any (odd) features of the data
you may need to understand before interpreting the figures?

a) the very large number of cases

b) the high number of missing responses

Why do you think this structure is commonly used in surveys?

If we ask different sets of questions to different sub-samples, we can increase the
overall number of questions that can be asked without adding to the length of the
questionnaire.

What percentage feels a bit or very unsafe walking alone after dark? Is this higher
or lower than you would have expected?
Around 29 percent

What percentage feels either a bit or very unsafe when home alone?
Around 7.2 percent feel either a bit or very unsafe when home alone. A much
lower than the proportion unsafe walking alone after dark

The questions ask about experiences over the last 12 months. What else is
referred to in the framing of the question? The question refers to places (‘at home,
in the street, at work, in a shop, in a park, on a train or anywhere else’)

How might these references affect responses? The references to time should
mean all responses relate to the same timeframe, which is the last year.
Mentioning of places can help respondents recall incidences and clear any
ambiguity about whether out or at home etc.

How might the question routing affect the number of valid and missing cases on
ndelibv?

A lower number of valid cases

A higher number of missing cases

What proportion has experienced deliberate violence? Less than 2 percent
Out of those who have experienced violence, how many times has it usually
happened? Only once

Complete the text to summarise the variable?

From the people who have experienced violence against them in the last year, the
number of incidences were between 1 and 50. The average was 2.02.
(Note:statistics calculated excluding those responding “97 or more / too many to
remember).

Why are there no cases reporting 0 incidents of violence?
Those not experiencing incidence of violence were not asked the question

What proportion of females feel ‘'very unsafe’ walking alone after dark? How does
this compare to males? 15 percent of females report feeling very unsafe walking
alone after dark: a much higher proportion than for males (3.4 percent).

Does the test suggests there is a significant relationship between sex and fear of
crime? Yes, the test suggests the difference between males and females is
statistically significant at the p<0.001 level.

Check the expected cell counts given below the Chi-square results. Does the data
meet the requirements of the chi-square test? In this case, the results are reliable
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as fewer than 20% of cells have expected counts of less than 5 and no cells have
less than 1.

Are males or females more likely to feel safe at home at night?

Males are more likely to report feeling safe at home at night. Around 97 percent of
males reporting feeling wither very or fairly safe compared to about 89 percent of
females.

According to the Pearson chi-square test, there appears to be a significant
association between sex and feeling safe when home alone at night.

Is age related to feeling unsafe walking alone after dark? Summarise the pattern
with reference to the percentages in the table.

The results suggest there are age differences in the fear of crime. Those in middle
age bands are more likely to report feeling safe both at home alone at night and
walking alone after dark. Younger and older adults are more likely to report
feeling unsafe. In particular, younger adults are more likely to report feeling
unsafe when at home alone at night and older adults are most likely to report
feeling unsafe walking alone after dark. For example, nearly 20 percent of those
aged 75+ report feeling very unsafe walking alone after dark compared to just
under 8 percent of those aged 24-44 and 45-64.

Using the information above, can you plan the recode for the new variable
identifying those who feel unsafe walking alone after dark?

Existing Variable = Walkdark New Variable= unsafedark

Value Label Value Label
1 Very safe } 0 No

2 Safe

3 A bitunsafe } 1 Yes

4 Very unsafe

8 Refusal 8 Refusal

9 Don’t know 9 Don't know

Do feelings of safety walking alone after dark vary according to experience of
violence?

Examining these variables, the relationship between experience and fear of crime
does not appear to be strong. On average, about 32 percent of people very safe
walking alone after dark; among those who have experienced violence it reduces
to 28 percent. The difference is then smaller looking at those who feel fairly safe,
which is 40 percent for those who have not experienced violence, compared to
41 percent for those who have.

Does there appear to be a statistically significant relationship between experience
of violence and the fear of crime?

Pearson Chi-Square (0.888, p=0.82) suggests the relationship is non-significant.

Among males, which of the following statements applies? Those who have
recently experienced violence feel less safe walking alone after dark.

Is the pattern the same for females? No, among females, feeling unsafe walking
alone after dark is not related to recent experience of violence.

According to the Pearson Chi-square test, is there a significant association
between fear and experience of crime...

...among males? Yes, at the 5 percent level of significance, the chi-square test
indicates there is an association between fear and experience of crime among
males

...among females? No, there does not appear to be a significant association
among the fear and experience of crime among females.
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